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Printer Specifications

Printing

Printing method On-demand ink jet

Nozzle 
configuration 128 black nozzles (32 × 4, staggered) 

64 color nozzles × 3 (cyan, magenta, 
yellow)

Printable columns 
and printing speed Up to 8 pages per minute in black, 

7 pages per minute in color

Character mode

Raster graphics mode (Printable area is 8.27 inches)

Resolution Maximum 1440 × 720 dpi (using driver 
MicroWeave)

Input buffer 32KB

Print direction Bidirectional with logic seeking for text 
and graphics

Control code ESC/P 2™ and expanded raster graphics 
code; IBM X24E emulation code; 
EPSON remote command

Character tables 1 italic and 10 graphics character tables

Character sets 14 international character sets and 1 
legal character set

Bitmap fonts • EPSON Roman (proportional)
• EPSON Sans Serif (proportional)
• EPSON Courier
• EPSON Prestige
• EPSON Script

All bitmap fonts are available in 10, 12, 
and 15 cpi. You can select other font/
pitch 
combinations using ESC/P commands.

Scalable fonts • EPSON Roman
• EPSON Sans Serif
• EPSON Roman T
• EPSON Sans Serif H

All scalable fonts are available in sizes from 8 to 32 points, 
in 2 point increments, and four styles: normal, bold, italic, 
and bold italic.

ink cartridge 
clamp

printer 
cover

output 
tray

output tray 
extensions

color print head 
cleaning button

black print head 
cleaning button

power 
buttonthickness lever

load/eject 
button

paper support extension

paper support control 
panel

edge guides

Character pitch 
(characters per inch)

Printable 
columns

Printing speed
(characters per second) 

Draft Normal (LQ)

10 80 533 400

12 96 640 480

15 120 800 600

17 (10 condensed) 137 912 684

20 (12 condensed) 160 1067 800

Print quality Available dots CR speed (inches per second) 

180 dpi  × 180 dpi 1488 26.7 

360 dpi  × 360 dpi 2976 20 

720 dpi  × 720 dpi 5952 20 

1440 dpi  × 720 dpi 5952 10 
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The printer always uses the fonts you select with your 
software application. You need to use the printer’s internal 
fonts only if your application doesn’t allow you to select 
fonts. Paper

Notes:
Since the quality of any particular brand or type of paper may 
be changed by the manufacturer at any time, EPSON cannot 
guarantee the use of any particular brand or type of paper. 
Always test samples of paper stock before purchasing large 
quantities or printing large jobs.

Poor quality paper may reduce print quality and cause paper 
jams and other problems. If you encounter problems, switch to 
a higher grade of paper.

Do not load curled or folded paper, envelopes, or 
transparencies.

Print on ink jet papers and envelopes only under these 
conditions:

Temperature: 59 to 77°F (15 to 25°C)
Humidity: 40 to 60% RH

Store glossy media and self adhesive sheets under these 
conditions:

Temperature: 59 to 86°F (15 to 30°C)
Humidity: 20 to 60% RH

Paper Type Size Paper Types Thickness Weight

Single Sheets Letter (8.5 × 11 inches) 
A4 (210 × 297 mm)
A5 (148 × 210 mm)
B5 (182 × 257 mm)
Legal (8.5 × 14 inches) 
Half letter (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)

Plain paper and special ink 
jet papers distributed by 
EPSON

0.003 to 0.004 inch 
(0.08 to 0.11 mm) 

17 to 24 lb (64 to 90 g/m2); 
use 24 lb (90 g/m2) paper under 
normal temperature and humidity 
conditions 

Transparencies and 
glossy media

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm, glossy film only)

Transparencies, glossy 
paper, and glossy film 
distributed by EPSON

Glossy film and transparencies: 
0.0051 to 0.0059 inch 
(0.13 to 0.15 mm)
glossy paper:
0.0067 to 0.0071 inch 
(0.17 to 0.18 mm)

—

Self adhesive sheets A4 (210 × 297 mm) Self adhesive sheets 
distributed by EPSON

— —

Envelopes No. 10 (9.5 × 4.1 inches, 
            240 × 104 mm) 
DL (8.7 × 4.3 inches, 
      220 × 110 mm) 
C6 (4.4 × 6.4 inches, 
      114 × 162 mm)

Plain, bond, or air mail 
paper

0.006 to 0.017 inch 
(0.16 to 0.43 mm)

12 to 20 lb (45 to 75 g/m2)

Cards A6 (105 × 148 mm)
5 × 8 inches (127 × 203 mm)
8 × 10 inches (203 × 254 mm)

Ink jet cards distributed by 
EPSON

0.0091 inch (0.23 mm) 50.7 lb (188 g/m2)
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Printable area

A The minimum top margin is 0.12 inch (3.0 mm).
When printing multiple sheets of glossy media, the minimum 
top margin is 1.2 inches (30 mm).

BL The minimum left margin is 0.12 inch (3.0 mm).
BR The minimum right margin is:

0.35 inch (9.0 mm) for Letter and Legal
0.12 inch (3.0 mm) for all other paper sizes
1.10 inches (28 mm) for #10 envelopes
0.28 inch (7 mm) for DL envelopes
0.12 inch (3 mm) for C6 envelopes

C The minimum bottom margin is 0.54 inch (14.0 mm).

Note:
Always load paper into the sheet feeder short edge first except 
envelopes. Load envelopes long edge first.

Ink Cartridges

* The print capacity may vary depending on how often you use the 
print head cleaning function. Also, if you print large graphics and 
dense text with little white space, you use ink faster.

** The ink thaws and is usable after approximately 3 hours at 77 °F (25 
°C).

Caution:
To ensure good results, use genuine EPSON cartridges and 
do not refill them. Other products may cause damage to your 
printer not covered by EPSON’s warranty.

Do not use an ink cartridge after the expiration date on the 
package.

A

B-L
B-R

C

A

B-R

C

B-L

Envelope

Single sheet

Specification Black ink cartridge (S020108) Color ink cartridge (S020089)

Color(s) Black Cyan, magenta, and yellow

Print Capacity* 900 pages (A4 paper; text at Normal - 360 dpi; 5%) 
(ISO/IEC 10561 Letter Pattern)

300 pages (A4 paper; Normal - 360 dpi, 5% each color)

Cartridge life 2 years from production date and up to within 6 months after opening package at 25 °F (77 °C)

Storage Temperature –4 to 104 °F (–20 to 40 °C)1 month at 104 °F (40 °C)

Transit Temperature –30 to 60 °F (–22 to 140 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing Temperature** –3.2 °F (16 °C) –0.4 °F (–18 °C)

Dimensions 1.09 (W) × 2.1 (D) × 1.5 (H) inches
27.8 (W) × 52.7 (D) × 38.5 (H) mm

1.7 (W) × 2.1(D) × 1.5 (H) inches
42.9 (W) × 52.7 (D) × 38.5 (H) mm
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Mechanical

Paper feed 
method Friction with auto sheet feeder, rear 
entry

Sheet feeder 
capacity Maximum 100 sheets of 17 lb 

(64 g/m2) paper

Dimensions Storage
Width: 18.7 inches (475 mm) 
Depth: 10.7 inches (274 mm) 
Height: 7.4 inches (177 mm)

Printing
Width: 18.7 inches (475 mm) 
Depth: 24.0 inches (610 mm)

27.2 inches (692 mm, 
when loading transparencies)

Height: 12.4 inches (315 mm)
7.95 inches (202 mm, 
when loading transparencies)

Weight 14.3 lb (6.5 kg) without the ink 
cartridges

Electrical

Environmental

Temperature Operation 50 to 95 °F (10 to 35 °C)
Storage*  –4 to 140 °F (–20 to 60 °C)

1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Humidity Operation 20 to 80% RH
Storage* 5 to 85% RH 

(without condensation)

*  Stored in shipping container

Safety Approvals

Safety standards UL 1950 with D3, CSA 22.2 950 
with D3

EMC FCC part 15 subpart B class B
CSA C108.8 class B

DOS Support

If driver support for the EPSON Stylus COLOR 800 is not 
available from your software manufacturer, you can use one 
of the other EPSON ESC/P 2 printer drivers. Choose the first 
printer available from the following two lists:

Black printing only

• LQ-870/1170
• LQ-570(+)/1070(+)
• SQ-870/1070
• LQ-850
• LQ-500

Color and black printing

• EPSON Stylus PRO
• EPSON Stylus COLOR 500
• EPSON Stylus COLOR II
• LQ-860
• LQ-2550

Control Panel
Specification 120 V model 240 V model

Input voltage range 103.5 to 132 V 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4A 0.2A

Power consumption Approx. 18 W (ISO/IEC 10561 Letter Pattern)

power button

load/eject button
color cleaning 
button

black cleaning 
button

paper out light

color ink out light

black ink out light

power light
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The four lights on your printer’s control panel show the 
printer’s status and alert you to problems like paper jams. 

Testing the Printer

You can run a self test to determine whether the problem 
comes from the printer itself or the computer. 

❏ If the results are satisfactory, the problem lies in software 
settings, the interface cable, or your computer.

❏ If the self test does not print correctly, you have a problem 
with your printer. 

Follow these steps to run the test:

1. Make sure both the printer and computer are turned off.

2. Disconnect the interface cable from the printer.

3. Make sure paper is loaded in the feeder.

4. Press the E load/eject button and hold it down while you 
press the Ppower button. Continue to hold the buttons 
until the Ppower light starts to flash.

The printer prints a nozzle check pattern and samples of 
fonts and colors. 

5. To end the test, turn off the printer.

Using Hex Dump Mode

You can use the printer’s hex dump mode to identify 
problems if you know how to interpret hex code. Or, you 
can fax the hex printout to a technical support 
representative. Follow these steps to use hex dump mode:

1. Make sure the printer is turned off and has paper in the 
feeder.

2. Open the cover.

3. Hold down the E load/eject button and the X color 
cleaning button and press the Ppower button. The printer 
prints Hex Dump Mode at the top of a page and then stops.

4. Print one or more pages from an application as usual. The 
printer prints the exact code it receives in hexadecimal 
format.

Default Control Panel Settings

You can change the following “default” settings from the 
printer’s control panel:

Changing control panel settings

Follow these steps to change the settings listed above:

1. Make sure the printer is turned off and has paper loaded.

2. Hold down the X color cleaning button and press the 
power button. The printer prints a summary of 
instructions for changing settings and choosing the 
language to use for additional instructions.

S When the paper light flashes, paper is 
jammed in the printer. Turn off the 
printer and gently pull out all jammed 
paper. Then press the E load/eject 
button.

S When the paper light comes on, your 
paper ran out or is incorrectly loaded. 
Load paper in the feeder and then press 
the E load/eject button. 

B A When an ink light flashes, your ink 
supply is low. Make sure you have a 
replacement cartridge.

B A When an ink light comes on, you need to 
replace the ink cartridge.

P When the power light flashes, the 
printer is receiving a print job or 
performing a maintenance operation.

P S B A When the power and paper lights flash 
and the other lights are on, your printer 
has a carriage error.

P S B A When all the lights flash, your printer 
may have an internal error.

Setting Options

Print direction Auto, Bi-D, Uni-D

Font Courier, Roman, Sans Serif, Prestige, Script, 
Roman T, Sans Serif H, Draft

Pitch 10 cpi, 12 cpi, 15 cpi, 17.1 cpi, 20 cpi, 
Proportional

I/F mode Auto, Parallel, Serial, Option

Auto I/F wait time 10 seconds, 30 seconds

Software ESC/P 2, IBM X24E

Auto CR (IBM mode only) Off, On

AGM (IBM mode only) Off, On

Character table PC437, PC850, PC860, PC861, PC863, PC865, 
Abicomp, BRASCII, Roman 8, ISO Latin 1, 
Italic U.S.A., Italic France, Italic Germany, 
Italic U.K., Italic Denmark 1, Italic Sweden, 
Italic Italy, Italic Spain 1

Auto line feed Off, On

Network I/F mode Off, On

Loading position 8.5 mm, 3 mm, Others

Economy Off, On

Parallel I/F transfer rate Fast, Normal
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3. Press the X color cleaning button to print a list of current 
settings and additional instructions.

4. After you make the changes you want, turn the printer 
off to save the settings. The settings remain in effect until 
you change them again.

Printing from Windows

When you want to print from your Windows application, 
you click the print icon or choose Print from the File menu. 
You can then choose which pages to print, the number of 
copies, and other options. The settings that describe your 
print job—whether you want to use color or black ink, for 
example—are part of your printer driver software. 

Note:
If you’re using Windows NT, you’ll need special software for 
your printer. Contact EPSON if you need printer driver 
software for Windows NT.

Setting Printer Options from Windows Applications

Follow these steps to check printer settings from your word 
processor or other Windows software:

1. Click the Print icon or choose Print or Print Setup from the 
File menu. You see a printing dialog box.

2. Make sure your EPSON Stylus COLOR 800 printer is 
selected, and then click the Printer, Setup, Properties, or 
Options button. (You may have to click a combination of 
these buttons.) You see a dialog box like the following:

3. Click the Main tab if necessary and make sure the Mode 
option is set to Automatic. This is the easiest way to get 
good printing results for all kinds of documents, on all 
types of paper.

4. Choose the Media Type you want to print on.

The type of paper or other media you choose determines 
the print quality or resolution you can use. See page 14 for 
guidelines on choosing paper.

Note:
For printing at the highest resolution (SuperFine quality 
at 1440 dpi), you need to use one of the photo quality 
media. For the best printing at any resolution, always use 
EPSON media.

5. Choose Color or Black ink.

6. Set the slider to Quality or Speed. This lets you choose 
between the fastest printing or the highest resolution for 
the media you’re using. (The slider is not available for 
certain media types.)

7. If necessary, click the Paper tab and choose your paper 
size, number of copies, and orientation. If your software 
application lets you control these settings, you don’t need 
to use the Paper tab. 

8. Click OK when you’re finished checking your settings. 
The dialog box closes.

If you’re using Windows 95, you can click Apply and 
keep the dialog box open.

9. In the printing dialog box, click Close, OK, or Print. You 
may need to click a combination of these buttons. 

Setting Windows Default Options

When you change printer settings through your software 
application, the settings apply only to the application you’re 
using. If you want to adjust the default settings for all your 
Windows applications, you can access the dialog box 
through the Windows 95 Settings option or the Windows 
3.1 Control Panel. 

Make sure all your software applications are closed before 
you start. If not, you’ll have to close and then reopen them 
to have the new default settings take effect.

Setting Default Options in Windows 95

Follow these steps: 

1. Click Start, point to Settings, and then point to Printers. 

2. Right-click the EPSON Stylus COLOR 800 icon. 

3. Select Properties. Then click the Main tab. 

You see the Main printer settings dialog box. Any changes 
you make will become the default settings for all your 
applications and documents. 

Click to see 
list of media 
types.

Click for 
more 
information.
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Setting Default Options in Windows 3.1 

Follow these steps: 

1. Double-click the Control Panel icon in the Main group. 

2. Double-click the Printers icon. 

3. Select EPSON Stylus COLOR 800 from the list of printers 
and click Setup. 

You see the Main printer settings dialog box. Any changes 
you make will become the default settings for all your 
applications and documents. 

Printing from a Macintosh

When you set up a new printer for your Macintosh, you 
need to check the page setup for documents in each 
application you use. You can then click the print icon or 
choose Print from the File menu. You see a dialog box that 
lets you choose which pages to print, the number of copies, 
and other options. The settings that describe your print 
job—whether you want to use color or black ink, for 
example—are part of your printer driver software. 

Follow these steps to check printer settings from your word 
processor or other Macintosh software:

1. Choose Page Setup from the File menu. You see the Page 
Setup dialog box.

2. Choose your paper size and other page setup options and 
click OK.  

3. Choose Print from the File menu or click the Print icon in 
your application. You see a dialog box like the following:

4. Choose the number of copies and indicate which pages 
you want to print.

5. Make sure the Mode option is set to Automatic. This is the 
easiest way to get good printing results for all kinds of 
documents, on all types of paper.

6. Choose the Media Type you want to print on. See page 14 
for guidelines on choosing paper.

Note:
For printing at the highest resolution (SuperFine quality 
at 1440 dpi), you need to use one of the photo quality 
media. 

7. Choose Color or Black ink.

8. Set the slider to Quality or Speed. This lets you choose 
between the fastest printing or the highest resolution for 
the media you’re using. 

9. Click Print when you’re finished checking your settings. 

If you chose background printing when you set up your 
printer, you can continue working while your document is 
printing. 

Note:
On the Macintosh, printer settings are saved with your 
document, but you can’t save them from one application to 
another. You’ll have to check your settings each time you 
open a new application. If you want to reuse settings, you can 
create document templates for your favorite applications.

Managing Print Jobs in Windows

Your Windows printer software includes two management 
utilities: the Spool Manager and Status Monitor. 

❏ The Spool Manager starts automatically when you send a 
job to the printer. It allows you to print in the background 
while you continue to work on your computer and to 
queue jobs to print at a later time. If you’re using your 
printer on a network, it also handles multiple print jobs 
that come in at the same time.

❏ The Status Monitor, which is available only if you’re 
using Windows 95, also starts automatically when you 
send a job to the printer. It displays in the lower right 
corner of your screen to alert you about printer and ink 
status, as described on page 9. 

Note:
The Status Monitor doesn’t work if you’re printing over a 
network.

Using the Spool Manager

The Spool Manager works like the Windows Print Manager.

❏ To open it while you’re printing, click the Spool Manager 
icon that appears on the Taskbar (Windows 95) or at the 
bottom of your desktop (Windows 3.1). 

Click for more information 
about printer settings.

Click to see list of 
media types.
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❏ To open the Spool Manager at any time, double-click the 
Spool Manager4 icon in the EPSON program group or 
folder.

You see the Spool Manager window:

When you send a job to your printer, your printer software 
creates a temporary journal file, stores it in the C:\TEMP or 
C:\WINDOWS\TEMP folder or directory, and assigns it to 
a print queue. The software then sends the file to your 
printer at the right time.

The Spool Manager window displays the status of your print 
queues and journal files and lets you control them. Here are 
some of the things you can do:

❏ Hold or release a queue

❏ Send journal files to your printer over a network 

❏ Hold, re-queue, or delete a journal file

❏ Select the information you want to see in the Spool 
Manager window

❏ Prevent the Despooler popup window from appearing on 
your screen whenever you print

❏ Change your default spool directory

Deleting a Stalled Print Job

If you’re having trouble printing, it may be because of a 
stalled print job. Follow these steps to delete it so you can 
continue printing:

1. Open the Spool Manager as described above.

2. Click on any print jobs marked Held, then open the 
Document menu and click Delete. 

3. Exit Spool Manager and try printing again.

Changing the Default Spool Directory

If you get an error message when you try to print, or 
printing is very slow, you can try changing your default 
spool directory. Follow these steps:

1. Make a directory on your hard drive where you want 
Spool Manager to store journal files, for example, 
C:\SPLTEMP.

2. Open the Spool Manager as described above.

3. Make sure EPSON Stylus COLOR 800 is selected, and 
then choose Setup from the Queue menu. The Queue 
Setup dialog box appears.

4. Change the spool directory to the one you created in 
step 1. Also make sure Use Print Manager for this port is 
checked. (If you don’t see the Status Monitor when you 
print, make sure it’s unchecked.) Then click OK.

5. Choose Default Spool Directory from the Options menu. 

6. In the dialog box, change the spool directory to the one 
you created in step 1. Then click OK.

7. Close Spool Manager.

Using the Status Monitor

The Status Monitor, available only if you’re using Windows 
95, displays automatically when you send a job to the 
printer. However, you can use it at any time to see how 
much ink you have left. Follow these steps:

1. Access the Main printer settings dialog box as described 
on page 6.

2. Click the Utility tab.

3. Click the Status Monitor icon. You see the Despooler 
window with the Status Monitor at the bottom.

4. Check the amount of ink you have left. For more 
information about the Despooler window, see the next 
section.

If the Status Monitor doesn’t appear on the Despooler 
window, you may need to check your bidirectional spool 
settings. Follow these steps:

1. Click Start, point to Settings, and then point to Printers.

queue journal file

menus
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2. Right-click the EPSON Stylus COLOR 800 icon.

3. Select Properties. Then click the Details tab. 

4. Click Spool Settings. 

5. Make sure Enable bi-directional support for this printer is 
turned on. Then click OK.

Using the Despooler

While your document is printing, the EPSON Despooler 
dialog box appears in the lower right corner of your screen:

This dialog box shows the progress of your print job and the 
status of your printer. If you run out of paper while printing, 
for example, the Despooler warns you. You can use the 
buttons to cancel, pause, or restart your print job. 

Note:
The Status Monitor appears only if you’re using Windows 95 
and you’re not printing over a network.

The Status Monitor at the bottom of the dialog box shows 
how much ink is left in your printer, along with these status 
icons:

Managing Print Jobs on a Macintosh

Your Macintosh printer software includes two management 
utilities: Monitor2 and Status Monitor. 

❏ If you’re using background printing, Monitor2 starts 
automatically when you send a job to the printer. It 
handles background printing while you continue to work 
on your Macintosh and lets you track documents that are 
waiting to be printed. 

❏ The Status Monitor alerts you to any problems that occur 
during printing. You can also use it at any time to see how 
much ink you have left. 

Using Monitor2

The Monitor2 utility lets you continue to work on your 
Macintosh while your document is printing. However, 
background printing is slower and may also slow down your 
system. 

If you want to use this utility, you need to turn on 
background printing in the Chooser and increase the 
memory allocation for Monitor2. Follow these steps to turn 
on background printing and use the Monitor2 utility:

1. Open the Chooser from the Apple menu and make sure 
your EPSON Stylus COLOR 800 printer is selected.

2. Under Background Printing, click On and close the 
Chooser.

3. Select EPSON Monitor2 in your Extensions folder within 
the System folder.

4. Choose Get Info from the File menu. 

The name of the 
file you’re 
printing appears 
here.

Click to pause 
printing.

Click to 
cancel 
printing.

Click to restart 
printing.

The Status Monitor is checking printer status.

An error has occured. Check your printer. 

Your printer is ready to print.

Your printer is printing.

The ink level is low or empty. Check the B or 
A light on the control panel and replace the 
cartridge if necessary.
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5. Set the Memory Requirements to 2000 or 3000, depending 
on your system’s available RAM.

6. While you’re printing, click the EPSON Monitor2 icon on 
the Application menu at the right end of the menu bar. 
You see a dialog box like the following:

7. You can select a job and cancel it or just use this window 
to track the printer’s progress. 

Using the Macintosh Status Monitor

You can use the Status Monitor to check the level of ink in 
your printer and to control the way your software warns you 
about printer problems. Follow these steps:

1. Choose Print from the File menu or click the Print button 
in your application. You see the printer settings dialog 
box.

2. Click the Utility button. 

3. Click the StatusMonitor icon. The software checks the 
amount of ink remaining in the printer and displays the 
StatusMonitor window:

4. If you want to change printer messages and warnings, 
click the Configuration button. You see the following 
dialog box:

5. Choose the options you want and click OK.

Network Printing on a PC

You can use your printer on a network under Windows 95 
or other network operating systems. First you need to set up 
your printer, using either your printer software’s built-in 
network support or the network’s LPT port redirection 
functions. 

Note:
If you need to install a network interface board in your printer, 
see page 17 for instructions.

When you use your printer’s built-in support, the Spool 
Manager sends journal files from your computer to a shared 
directory on a network server. These files can then be 
printed from another computer attached to the printer. 

First you need to run Spool Manager and identify the shared 
directory to use for journal files. After you set this up on the 
computer connected to the printer (the host system), you 
need to perform a similar procedure on each remote system 
on the network. 

Under Windows 95, you also need to specify the port and 
network path to the printer.

Setting Up the Host System

Follow these steps to set up the computer connected to the 
printer:

1. Create an icon for the EPSON Spool Manager 
(EPSPLMGR.EXE in the \WINDOWS\SYSTEM folder 
or directory).

2. Place this icon in the Startup folder.

3. Open the Spool Manager window as described on page 7.

Job currently 
printing

Jobs queued 
for printing

Click to recheck ink level.Click to control messages 
and warnings.

Printing stops 
when these 
messages appear.

Printing continues 
when these 
messages appear.
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4. In the Spool Manager window, double-click the queue you 
want to use for network printing. The Queue Setup dialog 
box appears.

5. Click the Remote Despool tab and then click the Printing 
from remote queues option.

6. Click the Browse button and select the remote server 
directory that will receive journal files.

7. Click OK and minimize the Spool Manager.

Setting Up Remote Systems

Follow these steps to set up computers on the network:

1. Create an icon for the EPSON Spool Manager 
(EPSPLMGR.EXE in the \WINDOWS\SYSTEM folder 
or directory).

2. Open the Spool Manager window as described on page 7.

3. In the Spool Manager window, double-click the queue you 
want to use for network printing. The Queue Setup dialog 
box appears.

4. Click the Spool to remote printer button.

5. Click the Browse button and select the directory you’re 
using for journal files on the host system.

6. Click OK and minimize the Spool Manager.

Setting Up Your Network Path in Windows 95

If you want to use your printer on a network running 
Windows 95, you need to set up the port and network path 
on the computer connected to the printer. Follow these 
steps:

1. Double-click My Computer.

2. Double-click the Printers folder.

3. Right-click the EPSON Stylus COLOR 800 icon and 
choose Properties.

4. Click the Details tab. 

5. Click the Add Port button, then specify the network path 
to the printer and click OK.

6. Open the Spool Manager window as described on page 7.

7. In the Spool Manager window, double-click your printer’s 
queue. The Queue Setup dialog box appears.

8. Make sure the Use Print Manager for this port option is 
checked. Then click OK.

Network Printing on a Macintosh

If you want to use your printer on an AppleTalk™ network, 
you need to install one of the optional interface boards: 
either the LocalTalk™ board or the Ethernet™ board. See 
page 17 for more information about optional interfaces.

Then you can use the EPSON Namer utility and set up your 
printer in the Chooser. The EPSON Namer was installed on 
your hard drive along with the other printer software. 

Assigning a Name to the Printer

Follow these steps to use the EPSON Namer utility:

1. Double-click the EPSON Namer icon on your hard drive. 

2. Click the EPSON Stylus(AT) icon in the Device Types 
window.

3. Select the zone where your printer is located.

4. Under New Name, type a name for your printer to 
distinguish it from other printers on the network.

5. Click Rename and then click Done.

Using the AppleTalk Connection

Make sure your printer is turned on and then follow these 
steps to set up your printer on an AppleTalk network:

1. Open the Chooser from the Apple menu. 

2. Click the EPSON Stylus(AT) icon.

3. Select the AppleTalk zone you want to use. A list of all 
printers connected to the selected zone appears on the 
right.

4. Click the name you assigned to your EPSON Stylus 
COLOR 800. You see a prompt asking you to confirm 
your choice.

5. Click OK.

If your printer name doesn’t appear, make sure the printer 
is turned on and correctly connected, then click RETRY.

6. To ensure compatibility, leave Background Printing 
turned off.

7. Close the Chooser when you’re finished.
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Replacing an Ink Cartridge

When a B black or A color ink out light flashes, the 
indicated cartridge is low on ink. This is a good time to 
make sure you have a new cartridge. When the light stays 
on, the cartridge is empty and you need to replace it.

Caution:
To ensure good results, use genuine EPSON cartridges and 
do not refill them. Other products may cause damage to your 
printer not covered by EPSON’s warranty.

Use these EPSON ink cartridges within six 
months of installing them and before the expiration date on 
the package:

❏ Black ink cartridge   S020108

❏ Color ink cartridge    S020089

When the A color ink out light comes on, you can continue 
to print with black ink. Simply turn the printer off and then 
back on again. When you print, make sure you choose Black 
as the Ink setting in your printer software. 

Removing an Empty Ink Cartridge

You can replace a cartridge when the B black or A color 
ink out light is either flashing or on. Make sure the printer is 
turned on and not printing before you start. Then follow 
these steps:

Caution:
To avoid damaging the printer, never move the print heads 
by hand.

1. Determine which cartridge needs to be replaced.

2. Lower the output tray and raise the printer cover. Then 
locate the Y black and X color cleaning buttons next to the 
control panel under the printer’s cover.

3. Press the Y black or X color cleaning button and hold it for 
three seconds. 

Caution:
If you press the cleaning button when no ink out light is 
flashing or on, the printer cleans the print heads, as 
described on page 16. If you need to replace an ink cartridge 
before the lights flash (because the ink is too old, for 
example) follow the instructions on page 13.

The print heads move slightly left and the Ppower light 
begins flashing. (The print heads return to their home 
position if you don’t proceed to step 4 within 60 seconds.)

4. Pull up the ink cartridge clamp. (Although the illustration 
shows the black ink cartridge, the procedure is the same 
for replacing the color ink cartridge.)

Caution:
Don’t open the clamp or remove a cartridge except to 
replace it with a new one. Once you remove a cartridge, you 
can’t reuse it, even if it contains ink.

The cartridge rises up from its holder.

5. Lift the cartridge out of the printer and dispose of it 
carefully. 

Warning:
If ink gets on your hands, wash them thoroughly with soap 
and water. If ink gets into your eyes, flush them 
immediately with water.

6. Follow the steps in the next section to install the new ink 
cartridge.

black cleaning 
button

color cleaning 
button
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Installing the New Cartridge

Once you have removed the empty cartridge, you’re ready 
to install the new one. Follow these steps:

1. Remove the new ink cartridge from its packaging. 

2. Remove the yellow tape seal as shown:

Caution:
You must remove the yellow tape seal from the top of the 
cartridge; leaving the tape on will permanently damage it. 
Do not remove the clear seal from the bottom of the 
cartridge; ink will leak out.

3. Lower the ink cartridge into its holder with the label 
facing up and the arrow pointing to the back of the printer.

4. Press down the ink cartridge clamp until it locks in place.

5. If you need to replace the other ink cartridge, follow the 
steps under “Removing an Empty Ink Cartridge,” and then 
steps 1 through 4 under “Installing the New Cartridge.”

6. Press the E load/eject button and close the printer cover. 

The printer moves the print heads and begins charging the 
ink delivery system. (Even if you don’t press the button, 
ink charging begins 60 seconds after you close the clamp.)

The Ppower light flashes, and the printer makes various 
sounds. Charging takes about two minutes. When it’s 
finished, you can print again.

Caution:
Don’t turn off the printer while the P power light is 
flashing, unless the printer has not moved or made noise for 
more than 5 minutes.

Replacing an Outdated Ink Cartridge

If an ink cartridge is more than six months old, you may 
need to replace it. How can you tell? You may notice that 
your printouts don’t look as good as they used to. If print 
quality doesn’t improve after cleaning and aligning the print 
heads, you can replace one or both cartridges.

Follow these steps to replace an ink cartridge before the B 
black or A color ink out light is flashing or on:

1. Make sure the printer is turned on and not printing.

2. Lower the output tray and raise the printer cover. Then 
locate the Y black and X color cleaning buttons next to the 
control panel under the printer’s cover.

3. Press both the Y black and X color cleaning buttons and 
hold them down for a few seconds until the print heads 
move to the left.

Caution:
To avoid damaging the printer, never move the print heads 
by hand.

❏ To replace the black ink cartridge, follow the 
instructions beginning with step 4 on page 12. 

❏ To replace the color ink cartridge, press the X color 
cleaning button and hold it down for a few seconds. 
After the color ink cartridge moves to the left, follow 
the instructions beginning with step 4 on page 12.

Loading Paper

1. Slide the left edge guide all the way left and pull out the 
output tray extensions.

black cartridge color cartridge
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2. Fan a stack of plain paper and then even the edges.

3. Load the stack with the printable surface face up. Push the 
paper against the right edge guide.

Note:
Don’t load paper above the arrow mark inside the left edge 
guide.

4. Slide the left edge guide back against the stack of paper.

Using Special Media

When you print on special media, you need to be careful 
about choosing the correct Media Type and Paper Size 
settings in your printer software. The following table lists 
the available EPSON media and the Media Type setting to 
choose for each one.

The type of paper or other media you use is one of the most 
important factors in determining the quality of your printed 
output. For example, you can achieve the highest resolution 
(SuperFine quality at 1440 dpi) only when you use EPSON 
Photo Quality media. The following tips will help you get 
the best results on any type of paper or other media.

Letterhead, Preprinted Forms, and Legal-size Paper

Note:
When you load paper, make sure the printable side is facing 
up. Some special media have a cut corner that you need to 
position correctly; follow any instructions in the package. 
Always handle sheets by the edges, and don’t touch the 
printable surface.

Load the top edge first. When you load legal-size paper, 
pull up the paper support extension as shown below:

EPSON ink jet media and their settings

Media name Size Part number
Media Type 
setting

EPSON 360 dpi Ink Jet 
Paper

A4 
Letter

S041059
S041060

360 dpi Ink Jet 
Paper

EPSON Special Coated 
Paper for 360 dpi 
Printing

Letter S041060

EPSON High Quality 
Ink Jet Paper

Letter S041111 Photo Quality 
Ink Jet Paper

EPSON Photo Quality 
Ink Jet Paper

A4
Letter
Legal

S041061
S041062
S041067

EPSON Photo Quality 
Glossy Paper

A4
Letter

S041126
S041124

Photo Quality 
Glossy Paper

arrow mark

EPSON Photo Quality 
Glossy Film

A4
Letter

S041071
S041072

Photo Quality 
Glossy Film

EPSON High Quality 
Glossy Paper

Letter S041072

EPSON Iron-On 
Transfer Paper

Letter S041001, 
S041002

EPSON Ink Jet 
Transparencies

A4
Letter

S041063
S041064

Ink Jet 
Transparencies

EPSON Photo Quality 
Ink Jet Cards

4.1 × 5.8 
(A6)
5 × 8
8 × 10

S041054
S041121
S041122

Photo Quality Ink 
Jet Paper

EPSON 720 dpi Index 
Card

4.1 × 5.8 
(A6)

S041054

EPSON Photo Quality 
Self Adhesive Sheets

A4 S041106

EPSON ink jet media and their settings

Media name Size Part number
Media Type 
setting
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EPSON 360 dpi High Quality and Photo Quality Ink Jet 
Paper

Caution:
Don’t use the cleaning sheets that may be included with 
your special media; they may damage the printer.

You can load paper up to the arrow mark on the left edge 
guide. If you use legal-size ink jet paper, don’t load it more 
than half way to the arrow mark.

EPSON Photo Quality Glossy Paper, Film, and 
Transparencies

Before you load glossy media or transparencies, put a 
support sheet (packed with the media) or a plain paper sheet 
beneath the stack. You can load up to 20 sheets of glossy 
paper, and up to 30 sheets of glossy film or transparencies. 

Note:
Use ink jet papers within one year of purchase. 
Use glossy media and transparencies within six months. 
Return unused sheets and envelopes to their original package 
as soon as possible. 

However, you may get better results by loading one sheet at 
a time. With multiple sheets loaded, the minimum top 
margin you can use is 1.2 inches (30 mm). If you want to 
use a smaller top margin, load and print one sheet at a time.

Remove each sheet from the output tray immediately after 
it’s printed. Make sure each sheet is dry before stacking.

To print on transparencies, remove the paper support and 
reposition it in the slots at the back of the printer as shown:

Envelopes

You can load up to 10 envelopes as shown below:

If ink smears when you print on envelopes or other thick 
media, set the paper thickness lever to the + position. Open 
the printer cover and position the lever as shown below. 
Then close the cover and print. (Make sure you return the 
lever to the 0 position before you print on other media.)

EPSON Photo Quality Ink Jet Cards

You can use these cards to print photographs that look 
almost as good as the ones you get from film processing. 
Make sure you set the paper thickness lever to the + position 
as shown above. 

You can load up to 30 cards at a time. Always place the 
included support sheet under the cards. When you’re ready 
to print, use your software to set the Paper Size option for 
the size card you’re using.

EPSON Photo Quality Self Adhesive Sheets

Use these sheets to print labels or stickers. You can load one 
sheet at a time.

Set the thickness lever to 
+ if ink smears when you 
print on envelopes or 
cards.
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EPSON Iron-On Transfer Paper

Note:
For iron-on transfers, make sure you reverse your image 
before you print it, especially if it includes text. Then the 
text will read correctly when it’s transferred. You can 
use the Flip Horizontal option in your printer software.

You can print photos, company logos, or 
anything else you want on this paper, and then transfer your 
images to T-shirts or other cloth items. Load one sheet of 
transfer paper at a time. After you print, follow the 
instructions that came with the paper to iron the image onto 
the shirt or other item.

Printer Care

Cleaning the Print Heads 

If your printed image is unexpectedly light or faint, or dots 
are missing from the image, you may need to clean the print 
heads. This unclogs the nozzles so they can deliver ink 
properly.

Cleaning the print heads uses ink, so clean them only if print 
quality declines. You can clean the print heads in either of 
the following two ways:

❏ With the Head Cleaning utility in your printer software 
(when the printer is on a local port rather than a network)

❏ Using the printer’s control panel buttons

Using the Head Cleaning Utility

Follow these steps to run the utility from a Windows 
computer or a Macintosh:

1. Make sure the printer is turned on but not printing, and the 
B black and A color ink out lights are off.

2. Access the main printer settings dialog box.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Head Cleaning icon.

Caution:
Don’t turn off the printer while the P power light is 
flashing, unless the printer has not moved or made noise for 
more than 5 minutes.

5. Follow the instructions on the screen to clean one or 
both print heads. Cleaning each head takes about two 
minutes, during which the printer makes some noise and 
the Ppower light flashes. 

When the power light stops flashing, you need to run a 
nozzle check.

6. Make sure paper is loaded in the printer and click Print 
nozzle check pattern (Windows) or Confirmation 
(Macintosh.

If your print quality has not improved, repeat the steps 
above.

Using the Control Panel To Clean the Print Heads

Follow these steps to clean the print heads using the control 
panel buttons:

1. Make sure the printer is turned on and not printing, and 
that the B black and A color ink out lights are off. 

2. Open the printer cover.

3. Press the Y black or X color cleaning button and hold it for 
three seconds. Cleaning takes about two minutes, during 
which the printer makes some noise and the Ppower light 
flashes. 

4. When the Ppower light stops flashing, repeat step 2 for 
the other print head if necessary. 

After you’re finished cleaning and the Ppower light stops 
flashing, you need to run a nozzle check. 

5. Access the main printer settings dialog box.

6. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

7. Click the Nozzle Check icon. See the next section for 
instructions on examining the nozzle check pattern.

If your print quality has not improved, repeat the steps 
above.

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print after cleaning 
the print heads. It should look something like this, with the 
lower pattern colored cyan, magenta, and yellow:

Each staggered horizontal and straight vertical line should 
be complete, with no gaps in the dot pattern. If your printout 
looks okay, you’re done. If any dots are missing, clean the 
print heads again, as explained in the previous sections.
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Aligning the Print Heads 

If your printouts contain misaligned vertical lines, you may 
need to align the print heads. You can align the print heads 
in either of the following two ways:

❏ With the Print Head Alignment utility in your printer 
software (when the printer is on a local port rather than a 
network)

❏ Using the printer’s control panel buttons

Using the Print Head Alignment Utility

Follow these steps to run the utility from a Windows 
computer or a Macintosh:

1. Make sure the printer is turned on and paper is loaded.

Caution:
Load paper that’s at least 8.27 inches (210 mm) wide. This 
prevents ink from spraying inside the printer and smudging 
your printouts.

2. Access the Main printer settings dialog box.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Print Head Alignment icon.

5. Follow the instructions on the screen to print a test page 
and select the correct alignment.

Using the Control Panel To Align the Print Heads

Follow these steps to align the print heads using the control 
panel buttons:

1. Make sure the printer is turned off and paper is loaded.

2. Open the printer cover.

3. Hold down the E load/eject button and the Y black 
cleaning button and turn on the printer. Then release the 
buttons.

The printer prints an instruction sheet that tells you how to 
align the print heads.

4. Follow the instructions on the printed sheet.

5. When you’re finished, turn off the printer to exit the 
alignment mode.

Cleaning the Printer 

To keep your printer working at its best, you should clean it 
several times a year, following these steps:

Caution:

Don’t touch the gears inside the printer.

Never use alcohol or thinner for cleaning; they can damage 
the printer components and case.

Don’t use a hard or abrasive brush.

Don’t get water on the printer components.

Don’t spray lubricants or oils inside the printer.

1. Turn off the printer, unplug the power cord, and 
disconnect the printer cable.

2. Remove all the paper from the sheet feeder.

3. Carefully clean away dust and dirt with a soft brush.

4. Clean the exterior of the printer with a soft, damp cloth. 
Keep the printer cover closed so water doesn’t get inside.

5. Clean ink out of the printer’s interior with a soft, damp 
cloth.

Using Optional Interfaces 

Your EPSON Stylus COLOR 800 includes both parallel and 
serial interfaces. You can connect it to a PC or Macintosh, 
or both at the same time. If you want to connect to another 
system or to a network, you can install an optional interface 
board. 

You can install the following interface boards in your 
printer:

Using Macintosh Interface Boards

If you are planning to install the LocalTalk board, you will 
also need two LocalTalk Locking Connector Kits (DIN-8 
version). Attach one connector box to the AppleTalk 
interface on the printer and the other to the printer port on 
the Macintosh. Then attach the LocalTalk cable between the 
two connector boxes. For more information, see the 
instructions that came with the connector kits.

If you install the Ethernet board connected to a thin coaxial 
(10BASE2) cable, and the printer is the last device on the 
network, you need to obtain a 50-ohm terminator. The 
Ethernet transceiver is included on the EPSON Ethernet 
board, so you do not need an adapter box for the printer. 

Type of interface board Model number Compatibility

Serial C823051 PC

32KB serial C832071 PC

32KB parallel C823101 PC

LocalTalk C823121 Macintosh

Twinax C823151 PC

Coax C823141 PC

Ethernet C823461 Macintosh/PC 
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Using the PC Serial Interface Board

Before you install the serial interface board in your printer, 
follow the instructions that come with the board for setting 
baud rate and parity. Refer to your computer documentation 
for information about matching the board’s settings to your 
computer system. You may also need to set the board’s 
handshake timing, error handling, and other data transfer 
conventions.

Installing Optional Interfaces 

Before you install an optional interface board in your 
printer, make sure the printer is turned off and all the 
printer’s lights are off. Then follow these steps:

1. Unplug the power cord from the electrical outlet (and from 
the back of the printer, if your printer’s power cord is 
removable).

Caution:
To avoid damaging your printer or computer, do not install 
the interface board when the printer is connected to an 
electrical outlet. 

2. Turn the printer around so that its back faces you, and 
disconnect any interface cables.

3. Use a cross-head screwdriver to remove the two screws 
securing the shield plate to the interface slot; then lift off 
the plate. Be sure to keep both screws; you may need to 
use them again when you reinstall the shield plate.

4. Be sure to set any switches and jumpers on the board. See 
the interface board’s manual for details. If your board has 
a jumper labeled JG, make sure that you set it to on, or the 
board will not work properly.

5. Slide the interface board along the slots on both sides of 
the compartment. Push it in firmly to fully insert the 
board’s connector into the printer’s internal socket.

6. Secure the interface board in the slot with the two screws 
included with the interface board.

7. Connect the proper interface cable to the interface board 
and to your computer. If the cable has a grounding wire, 
connect it to one of the screws securing the parallel 
interface.

Also, if you are using more than one computer, reconnect 
the other interface cable.

8. Make sure the printer is turned off. Then plug in the power 
cord.

In most cases, the printer automatically detects the interface 
you’re using. However, if you have trouble printing through 
an installed interface board, you may need to change the 
printer’s I/F (interface) mode setting. See page 5 for 
instructions. 

To remove the interface board, follow the above steps in 
reverse order.

Information Reference List

Engineering Change Notices

None

Product Support Bulletins

None

Technical Information Bulletins

None
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Related Documentation

TM-STYCLR800 EPSON Stylus COLOR 800 
Service Manual

PL-STYCLR800 EPSON Stylus COLOR 800 
Parts Price List

4006678 EPSON Stylus COLOR 800 User’s 
Guide

4006677 EPSON Stylus COLOR 800 Quick Setup 

CPD4457 Installing Your Software
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